Learn how to:

* Change Desktop
Themes

* Give Your Dock a
Makeover

* Go Application
Dumpster Diving

* Explore Application
and System
Resources

* Change System and
Alert Sounds

* Customize
Application Icons

* Hack Property List
Files

* Discover
Undocumented
Preferences

7

* Alter an Application’s
Interface

» Change Keyboard
Shortcuts

* Script the
Unscriptable

and more...

O’REILLY*"

MODDING

MAC OS X

Extreme Makeovers

g

for Your Mac

Erica Sadun



Application Dumpster
Diving

If you're not afraid to get messy, and you're willing to dive into the complex
jumble that is an application’s Resources folder, you’ll find yourself well
rewarded. Most Mac OS X applications are brimming with cool stuff, and
nearly all of that is packed into the Resources folder. It’s there that you’ll find
sounds, pictures, movies, and other fun reusable or, better yet, customiz-
able items.

Whether you’re mining for goodies or changing the application to make it
“more you,” a strong heart and a desire to explore are your best tools. You’ll
learn what it takes to start playing with resources. You’ll customize sounds
and pictures and strings and localize those custom files. You’ll use the com-
mand line to search by extension and learn the best way to view the results.
After working through this chapter, you’ll know how to find and reuse the
very best an application has to hide.

Preparing to Dive

Erica: | wonder whether this stuff that explains the Chinese
Take-Out Equivalents should go into the Preface? It almost
seems like that’s a better place for it; what do you think?

Know who you are. Before you start messing with Mac OS X applications,
you need to know how far you're willing (and able) to go. Are you the kind
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Preparing to Dive

of person who gets plenty of rest, wears a warm scarf, and doesn’t go swim-
ming for an hour after eating? Or are you the kind of person who hops on a
mountain bike, doesn’t wear a helmet and welcomes bugs in your teeth?

In all likelihood, your Macintosh is probably working properly right now.
The applications you’ve installed are functioning and everything is in its
correct (or at least its default) place. Once you start playing with applica-
tions, this may all change. No matter your comfort level, you’ve got to have
a plan in mind for when you truly and utterly mess up.

The following approaches range from cautious explorer to reckless aban-
don. Despite that span, each has a contingency; a plan for getting out of any
fix you might find yourself in.

Just one last point to keep in mind: no matter what customizations you
make to your applications, they may very well get overwritten the next time
you upgrade that application. So, in addition to backing up your originals,
you should probably back up your changes as well.

Full Control (Chinese Take Out Equivalent: Mild Vegetables in a Tasty
Sodium-Controlled Light Wine Sauce)

Despite the fact that applications are bundled and modular, they do gener-
ally create, use, and modify other files on your computer. For the highest
level of responsible exploration, make a full backup of your hard drive
before attempting to experiment with and/or modify your Mac OS X appli-
cations. Use a program such as Carbon Copy Cloner (http://www.bombich.
com/software/ccc.html) or Dantz Retrospect (http://www.dantz.com/) to
completely back up your Mac’s hard drive. Or, if you have a .Mac mem-
bership and external FireWire drive (or a bunch of blank CD-Rs), use the
Backup application. Should difficulties arise, you can perform a full restore
of your computer to the state before you began to experiment.

High Control (Chinese Take Out Equivalent: Shredded Chicken with
Garlic Sauce)

With the exception of such lame ducks as iMovie 4, applications are a lot
more robust than you might think. If you feel that a bit of mild customiza-
tion won'’t really hurt any ongoing projects or affect critical data, just copy
your application. Select it in the Finder and choose File > Duplicate (38-D).
The Finder copies the bundle at every level from the highest subfolder to the
lowest. Then go ahead and experiment.

Pedants will note that duplicating an application can change the copy’s ownership
from root:admin to username:admin. Keep this in mind while working through
the examples in this book and, if desired, change the ownership with chown (i.e.,
sudo chown root:admin iPhoto.app). You'll be prompted for an administrator
password.
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Figure 3-1 demonstrates how Mac
OS X allows you to copy and use
multiple versions of otherwise iden-

Preparing to Dive
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Figure 3-1. Two coexisting copies of

Unfortunately, some applications are big. iDVD alone occupies over a giga-
iPhoto using different icons.

byte of disk space. If youre short on space, or if you think that copying
entire applications is overkill, you can limit your scope. Make copies of just
those files you're going to alter. Say, for example, that you want to custom-
ize a program’s About box; just copy an original file (e.g., AboutImage.tif)
and save that copy with a slightly altered name (e.g., AboutImage.orig.tif).
Then proceed with your changes. You’ll need to work on a file-by-file basis
to restore the application. It may help to make a log (by hand or in TextEdit)
to keep track of your changes. As a rule, don’t move original files out of
their folders unless you’re confident that you can later put them back where
they belong.

Master Geek (Chinese Take Out Equivalent: Ma Po Tofu, extra spicy)

If you're a geek who has achieved that perfect state of caffeine transcen-
dence, then consider customizing without a net. Jump in and feel the burn.
People in this final category always have the most fun and generally need
the most antacid. I can promise you that Apple does not have a safety squad
who will rush out (a la the Fab 5) and slap your fingers for messing with the
applications you've installed on your own computer. Do you want to defy
Apple’s Human Interface Guidelines? Go ahead. Do you want to personal-
ize, customize, and do the wacky? Do it. Mess up? Well, you can always
reinstall the application, or the system itself. Or pony up to buy one of those
fancy G5’s that you've been wanting.

The Xcode Tools

Apple’s Xcode Tools include the environments, documentation, applica-
tions, and utilities programmers need to design, program, and package Mac

©
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The Xcode Tools

OS X applications. They also contain the same environments, documenta-
tion, applications, and utilities that end-users can use to customize already-
built applications. The standard Xcode Tools collection is bundled with
Mac OS X on a separate disc, which you must install. You can also down-
load the latest distribution directly from the Apple Developer Connection
(ADC) web site (http://developer.apple.com).

You must sign up for a free membership with ADC before you can download the
developer distribution. The distribution can take hours—or days—to download
and you may be better off ordering the $20 CD.

When installed, the developer distribution appears in the top-level Mac OS
X hierarchy in the Developer folder. Key subfolders include:

Applications
The primary developer applications. Highlights include Interface
Builder (for interface customization) and Xcode (for project develop-
ment).

Applications/Utilities
The special-purpose tools that augment the main developer applica-
tions. Here’s where you’ll find Icon Composer (icon creation tool), icns
Browser (icon inspector), and Property List Editor (tool to create and
edit property lists, or plists).

Documentation
All the information you could possibly ever need to know about devel-
opment for Mac OS X. Important items include UserExperience (the
Human Interface Guidelines) and DeveloperTools (how to use all the
items in the developer distribution).

Tools
Helpful command-line utilities for managing and updating Mac OS
X applications. Standouts include SetFile, which lets you set applica-
tion metadata including type and creator; GetFileInfo, which retrieves
application metadata; and CpMac, which copies files and includes their
resource forks.

Take some time to explore the Developer folder and discover the goodies
found within. Many items will prove useful when you want to customize
application bundles. Others are useful only to programmers. There are even
a few items that may not help you work with applications but are just fun.

For example, the /Developer/Applications/Utilities/Built Examples folder
offers a few fun apps:

* Sketch is a simple but useful MacDraw-style program.

* BlastApp brings the classic NeXT helicopter game back to life.

)
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* World Text lets you create and edit Unicode strings.

* Appearance Sample shows off Interface Builder’s suite of interactive
controls.

* SimpleText does exactly what you remember, except this version has
been built for Mac OS X.

Help and Xcode Tools

It takes an extra step if you want to use the Help Viewer to search for docu-
mentation from the Developer distribution. The reason for this is because
Mac Help and Developer Help are indexed separately. Use these steps to
search through Developer Help.

1. In the Finder, choose Help = Mac Help (88-?). Mac OS X Help launches
and opens a new window.

2. Locate the magnifying glass in the Mac Help search field. It’s at the top-
right of the help viewer window, as shown in Figure 3-2. Choose Search
Developer Help (or Search All Help) from the pull-down menu.

As a rule, use the index pull-down to select a help topic whenever you
want to change the scope of your search. When the developer distribu-
tion has been installed correctly, and help is launched from the Finder,
the choices will include (at a minimum) Search Mac Help, Search All
Help, and Search Developer Help. (The first option listed generally
reflects the program that launched help.) Choose either of the latter two
to access topics from the developer documentation.

8eoe Mac Help (=)
<« (@ Q| )
¥ Search Mac Help
Search All Help
Search Developer Help .
-\,, _¥r Browse Mac OS Help
\ 4 What's New in Panther?

/

; Top Customer Issues
Connecting to the Internet
Setting up and using email

Printing documents
Installing software updates

Mac OS Help About your computer

More topics...
www.apple.com

New to Mac OS5 X?

Figure 3-2. The Help window.

The Xcode Tools

TOOLS YOU NEED:

HELP & XCODE TOOLS
For working through the examples in
this section, you'll need the following
application:

* Help Viewer (/System/Library/
CoreServices)

Chapter 3, Application Dumpster Diving
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Finding Goodies

3. Type a phrase into the top-right search field and
press Return.

CXeYG) Search Results =) 4. After searching, the Help Viewer returns a list of all
- &8 (@ changing icons ) the topics it can find that relate to the search phrase
opic TRelévance ¥ Location . . .

Chihgng s master pssworo e ey you entered. Select any of the listed topics. A topic

The settings | want to change are dimmed 4 Mac Help

summary appears in the text area at the bottom of
Changing the PIN for ...ur Common Access Card WIIIE | Mac Help . . . i
Changing shortcuts for Expaseé W M Hel ‘ the window, as shown in Figure 3-3. Double-click the

Changing the applicati... that opens a document WIIMNE [ Mac Help

cherglngme sles of dincow m— L \rac Hel hyperlinks in this text area to read more. Links lead
| can't change my computer's settings W Mac Help

AbouCQueyt=:Eirsme — K MacHcp to comprehensive overviews of the selected topic.
Changing the overall look of Mac OS X WL Mac Help

How to Change Color Depth and Resolutions L ATI Help
Changing the region code of your DVD drive Ly !'j DVD Player Help

Changing contrast WM =5 HP PrecisionScan Pro H...

Changing the hue WM =5 HP PrecisionScan Pro H... = = =

Making optional adjustments, advanced WM =5 HP PrecisionScan Pro H... Flndlng GOOdIeS

Changing settings for buttons W =y HP PrecisionScan Pro H... |9

To change settings for buttons W = HP PrecisionScan Pro H... |4

Changing the SCS! address W5 P Precisionscan Pro H...[¥ Any number of worthy and curious files can be found

Changing the way Iook on the desktop L. . . . .

V;Jngﬁg(lh:n::rilsnsr:;ezﬂf i::)r:é :n lise :jisklnp, how they are labeled, and how they're Wlth]n an appllcatlon bundle’s lnnards' A healthy nosi-

arrar_lged. | . . .

Taplclocaped in:Mzc Hal ness will help you discover some of them. Snooping
4 through resource folders is a skill that can be honed and

developed. Start with this basic approach.

Figure 3-3. The Help Viewer lists all the . Lo . L N
topics it can find that relate to the phrase Navigate to the Applications folder. Pick any application that intrigues

you enter in the search field. you; in this case, use the Mail application.

—_

2. Control-click (right-click) the application you have selected and choose
Show Package Contents from the pop-up, as shown in Figure 3-4.

3. To quickly view what’s inside the Contents folder, hit the C key and then

TOOLS YOU NEED: use the keyboard shortcut 88-3 to switch the Finder to Column View.

FINDING GOODIES

For working through the examples in 4. Select the Resources folder, located within the Contents folder.
this section, you'll need the following
applications:
* Mail (/Applications) ; ——a L Anplications —=
) ol &= @@ ceriee (5] g
And, optionally: @ tevwork ) r
@
 QuickTime Player (/Applications) & sors ;
Untithed -
e Lingln LiveType mACIdec
* iTunes (/Applications) ?";:'“: k
*  Preview (w) T mmmu . Bﬁ o
[ Mo i Get Info == |
é Music Etoriakar farriar Mlzro_s_.ohﬁiﬂux
71 Pictures * G0 eeee
B EIED ﬁ
Ij Develnper SNCE | k
L& Trash Make Allas .
Create Archive of "Mail™
Copy “Mall”
Taast It
Enable Folder Actions
Configure Folder Actions.
Stuffic

Figure 3-4. Show Package Contents exposes application contents.
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5.

When surfing through an application bundle, it’s

Finding Goodies
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best to organize your folders by file type. This :
groups together similar kinds of items, and allows -
you to see all the audio files or all the icon files e
at once. Choose View — Show View Options (8- ;::'; 2
J). Select Keep Arranged By — Kind, as shown in Poosas |
Figure 3-5. B Oosumgee

i Mo
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purposes and which ones you might want to alter 2
when customizing the application. You may want —_—
to develop a list of the relevant files, their location

) meturs.

and a brief description of their contents. Make sure
to browse through the localized Iproj files as well as
the main Resources folder.

Image and sound files are among the easiest to assess. Use
Preview to view images, and the QuickTime Player or the Finder itself to
listen to the sounds. If you’ve set up iTunes to automatically import sounds

(as T have), using QuickTime rather than iTunes allows you to preview audio
without adding a hundred little sounds to your iTunes library. (See Chapter
4, Changing Icons to read more about setting application associations.)

Changing Sounds

Because of its simplicity, the Mail application provides a terrific guinea pig
for learning how to swap AIFF files. Follow these steps to change the “No
Mail” sound to an AIFF file that you select.

1.

Quit Mail if it is running. In fact, you should always quit any applica-
tion before you attempt to modify its resources.

. Open the Mail application package and navigate to Contents/Resources.

“No Mail.aiff” appears in the Resources folder. Select the “No Mail.aiff”
file in the Finder, and then click on the play icon to listen to the origi-
nal, metallic sound.

. Next, create a backup copy of the “No Mail.aiff” file. There’s no con-

vention on how you should rename it; just give it a name so that the
original file can no longer be found by the application. In this case, I've
renamed the file as “No Mail.orig.aiff”.

Move a new, short (1 or 2 seconds, max) AIFF file into the Resources
folder and rename it as “No Mail.aiff”. Mail is hardwired to look for a
file named “No Mail.aiff” and to play that sound if no mail is found on
the server.

. Launch Mail by either clicking on its icon in the Dock, or by double-

clicking on its icon in the Applications folder.

Figure 3-5. Arrange your resources by
kind for easy browsing.

TOOLS YOU NEED:
CHANGING SOUNDS
For working through the examples in

this section, you'll need the following
applications:

* Mail (/Applications)
And, optionally
* iMovie (/Applications)

* SnapzPro (http;//www.
ambrosiasw.com)

* Audio Hijack (http;//www.
rogueamoeba.com)

« GarageBand (/Applications)

* Soundtrack (http;//www.apple.
com/soundtrack)

Chapter 3, Application Dumpster Diving
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Changing Sounds

6. Choose Mail — Preferences
8ene General () (88-,) from the menu bar, and

@ @ @ o @ ;}r % then click General to open the

General | Accounts Junk Mail Fonts & Colors Viewing Composing Signatures Rules General settmgs [2aTIES Ensure

that Play Sounds For Other Mail

Default Email Reader: rﬁ Eudora (6.0.2) M Actions is checked (as shown in
Check for new mail: | Every minute M Figure 3-6), and then close the
: ( - Preferences window.
New mail sound: L New Mail Sound M

G 7. Check your mail. If mail has
%F‘Ia‘yr sounds for other mail actions

. e @ arrived, wait for it to finish trans-
— Enables sounds to be played when mail is _Fh'"g f . di di 1 heck
sent, when no mail was fetched or when a | i errmg an immediate y chec
W fecch error occurs " your mail again. Keep checking
until no new mail is retrieved.
Figure 3-6. Mails General Settings When there’s no new mail, Mail

QR ceslpane. will play the new sound file.

Symbolic links and aliases provide a way to use sound files from one application in
another. Use the Terminal to rename an original sound (e.g., No Mail.aiff.bak). Then
use the link command to create a new version of the file (e.g., In -s /Applications/
foo.app/Contents/Resources/English.Iproj/blort.aiff No\| Mail.aiff)

Internationalizing sounds

Move beyond simple sound customization by internationalizing your AIFFs.
It’s surprisingly easy to accomplish. Just move language-specific versions from
the main Resources folder into localized Iproj folders. Here’s how:

1. Create several AIFF files that state there’s no new mail. If you don’t
TOOLS YOU NEED:

INTERNATIONALIZING actually speak more than one language, use funny accents instead.
SOUNDS Make sure the different versions are distinct and can be easily identified
For working through the examples in when played back.
this section, you'll need the following
applications: Keep in mind that there’s no official Apple support for Ubbi Dubbi or Latin (not

SN Wail (/Applications) even the Pig and Classic varieties).

« System Preferences (/Applications)
2. Make sure that the Mail application is not running; if it is, quit Mail

(Mail = Quit Mail, or $8-Q).
3. Open the Resources folder in Mail’s application bundle.

4. Copy the file named No Mail.aiff to No Mail.orig.aiff. This creates a
backup before you add the primary language version.

®



Recording Sounds

Although you can use existing sound clips to customize your
applications, sometimes it's more fun to record your own.
GriffinTechnology produces the iMic (http;//www.griffintechnol-
ogy.com/products/imic/), a USB interface that allows you to
plug in a microphone or connect any other audio source.

When recording with the iMic and a microphone, make sure
to push the small black switch toward the speaker icon. This
enables the internal amplifier, bringing your microphone input
into audible levels. To record from a CD player or other pre-
amplified source, set the switch toward the microphone, to use
line-level mode.

Once you've connected your input device to the Macintosh,
use the Sound panel in System Preferences to select the sound
input device and test the levels. Make any adjustments so the
levels stay within the middle of the input range.

There are a number of Classic and OS X applications that allow
you to record sounds. In addition to all the normal Sound
Recorder-like applications, you might consider a few oddball
approaches. For example:

« iMovie allows you to record audio. It saves that recorded
audio as AIFF files in the project Media folder.

* Snapz Pro (http,//www.ambrosiasw.com) is a screen capture
utility but it also lets you record from the microphone and
save the results to a QuickTime movie.

« Audio Hijack (http;//www.rogueamoeba.com) lets you hijack
your microphone with its free Sound Source application.

* GarageBand and Soundtrack (http.//www.apple.com) both
let you create custom AIFFs by editing loops and outputting
the result to a file.

Sound Advice

Although it's occasionally fun to have your computer speak to
you, fun has its limits. After you finish experimenting, you may
want to restore the original sounds that come with the Mail
application.

Despite the overwhelming success of AOL's “You've Got Mail,”
there are good reasons that Apple engineers use subtle audio
cues rather than boldly spoken phrases. Many people use their
Macintoshes in home or office environments where quiet is a
commodity.

| remember back to the old days of the NeXT computer, when
the company briefly (but memorably) experimented with voice
cues for their applications. One afternoon, the pre-recorded

voice of my NeXT announced that the “Printah has run out of
Paypah” for the hundred-oddth time. My husband, who had
been resting in the adjoining room, ran in, shouting that some-
day, he was going to kill that $@*&ing British woman.

As far as applications go, understated sounds almost always
produce the best results. They provide just enough feedback, so
you know that an operation has occurred, but not so much that
they draw attention to themselves. Apple continually spends
time, effort, and money engineering the sounds that ship with
their applications. Use the audio found throughout their apps as
a model for your own sound engineering needs.

Chapter 5, Building a Kick-Ass LAN Party PC
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Changing Sounds

5. Replace the file named No Mail.
aiff with the version you record-
ed in your primary language.

006 AR o 6. Move the new version of No

i e 1906 GR wralable Mail.aiff into the Iproj folder for
| — 0 your primary language, such
(@)

as English.lproj. This leaves the

‘ main Resources folder without a
AIFF =

No Mail.aiff sound file.
No Mqil.aiﬁ MailHelp AccountPreferences.nib
i L 7. As described in the last section,

launch Mail and ensure that the
proper sound plays back when
you check for new email. When

- you’re satisfied that everything
ActivityPanel.nib ActivityViewEntry.nib AddressHistory.nib ; Stlll WOka, desplte the flle I'ClO-
cation, quit Mail (8-Q) and
] ] ] return to the Resources folder.
Figure 3-7. Mails French.Iproj folder.

8. Select one of your alternate lan-
guage recordings. Rename the
file to No Mail.aiff and place it

800 International (=) in the appropriate Iproj folder,
. N Q@ @ ] such as French.lproj. This cre-
Show All Displays Sound Classic Sharing Desktop & Screen Saver ates two VeI'SiOI’lS Of NO Mall.alff
f | Formats | InputMenu } each in an Iproj folder, leaving
Languages: no copies in the main Resources
F J Drag languages to set your preferred *x N . %
rmsasn order for use in application menus, fOlder' reference Flgure 3_7
English dialegs, and text processing.
Iraliana /i\ Changes take effact in the Finder the next 9. Launch System Preferences,
British English time you log in. Changes take effect in . . ) 3
Y applications the next time you open them. elther by Cllcklng on 1ts DOCk
icon or from the Apple menu, and
(1) Your preferred language differs from that then click on the International
of your currently selected date, time, and
number formats. You can change your panel .
formats in the Formats tab.
10. Use the instructions from
Chapter 2, Choosing Localiza-
tions, to add and then select the
Customize Sorting.. ®
language used by your alternate
audio file. Make sure to drag
———eeeoooooooomarooo .
this new preferred language to

Figure 3-8. Choosing a primary language the top of the list. “reference

in the International pane. Figure 3-8*

11. After changing your language
settings, restart Mail. As before,
check for new mail. If you've
changed the language to French,

64
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click on the Relever button; other icon titles vary by language.
Assuming that no mail is found, your new localized version of the No
Mail.aiff sound clip plays back.

12. Once you're convinced that the sound localizations work as promised,
quit Mail (88-Q). Return to System Preferences, open the International
preferences panel and restore your primary language.

Searching Through Alternate Locations

As you just saw, one of the easiest customization tasks you can make is to
replace a sound file with one that has your own twist. For many applica-
tions, it proves extremely simple to adapt or replace alert sounds. Mail
is just one of these many easy-to-change apps, since Mail stores its alert
sounds as Audio Interchange File Format (AIFF) files in the top Resources
folder. Replace the sound file and you've replaced the sound. It’s as simple
as that.

Unfortunately, not all applications are so standard. Unlike Mail, many of
iChat’s sounds are stored outside the application bundle. They can some-
times be found in an external framework. Frameworks, which are discussed
further in Chapter 2, provide a modular way to program and deliver Mac
OS X applications.

To locate iChat’s audio files, navigate to the /System/Library/
PrivateFrameworks./InstantMessage.framework folder. Select the latest ver-
sion (alphabetically) and open the Resources folder; for example, Versions/
A/Resources (also known as Versions/Current/Resources). This directory
contains iChat’s “missing” AIFF files.

Despite complexity of location, both iChat and Mail use the same strategy
for loading sounds. When you replace an AIFF file, you replace the sound
used by that application. This works even when the sounds involved do not
appear within the application bundle.

For some applications, however, replacing sounds is quite difficult. iTunes
(at least up to version 4.5) was built using a very Classic approach. Its
resources occur in an RSRC file rather than in individual AIFFs. You’ll
need to use ResEdit, or some other resource editor, to listen to or alter its
one sound, a chime sequence called Encoding Complete. CodeWarrior offers
particularly robust resource editing tools. Unfortunately, Mac OS 9 (or
earlier) development skills are generally necessary to update these kinds of
sounds.

Search strategies

As iChat demonstrates, useful and customizable material can be stored in
more places than just the application bundle; you just have to be willing

Searching Alternate Locations

Chapter 3, Application Dumpster Diving
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Searching Alternate Locations

TOOLS YOU NEED:
SEARCHING FOLDERS

For working through the examples in
this section, you'll need the following
application:

« Terminal (/Applications/Utilities)

to poke around on your system a bit. One particular Unix command also
helps, making it very easy—and quick—to search.

Focus on these three principle directories:
» /Applications
e /System/Library/Frameworks
e /System/Library/PrivateFrameworks

These directories tend to contain all kinds of interesting and amusing files.

Searching application folders

To search through the Applications folder for AIFF audio files, you need to
search both the main Resources folder and at least one localization folder.
Here are the commands to search the main folder:

$ cd /Applications
$ 1s .app/Contents/Resources/x.aiff

When you issue the second command (Is), the Terminal returns a list of
matching file names. These files appear in various applications’ Resources
folders and are listed with their paths.

Next, search through English.lproj folders. This helps you discover any
internationalized files that may not appear in the main folder. English.lproj
appears in most application distributions, for most countries. (Japan is
rumored to have a problem in this area.) Where necessary, substitute your
primary language.

$ 1s .app/Contents/Resources/English.1lproj/.aiff

To search for other kinds of files, other than AIFF sounds, use the above
methods with different extensions. The commands you just saw make it
particularly easy to track down application resource files (.rsrc), images
(usually .tif or .tiff, but also try searching for .gif, .jpg, etc.), movies (.mov),
and so forth.

Searching with the locate command

The locate command can find files that match a particular pattern. This
makes it easy to search for all aiff files (*aiff), or movies (*mov) on your
computer. To use this utility, you’ll need to update the locate database.
This database is created and maintained as part of the weekly maintenance
routines (/etc/weekly).

To use locate, issue a locate *.aiff command at the Terminal’s command line.
You may want to pipe the results through more to page through them or
through open —f to open the results in TextEdit. For example:

$ locate *.aiff | open -f
$

)
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Searching Alternate Locations

You can update the locate database by running the updater directly (sudo
fusr/libexec/locate.updatedb) or by running the weekly maintenance (sudo
Jetc/weekly).

Searching with inodes

Help subfolders also contain intriguing multimedia material, including
movies, which are often found in the Iproj folders because they’re almost
always localized. Unfortunately, there’s no consistent naming pattern, other
than the presence of the word help. Some applications use spaces (e.g., DVD
Player Help and QuickTime Broadcaster Help), while others do not (e.g.,
MailHelp and PreviewHelp).

Although help folders use these arbitrary names, they are all highly struc-
tured, in a very non-arbitrary manner. For example, the pgs and pgs2 folders
contain source HTML. The gfx (short for “graphics”) and shrdgfx (short for
“shared graphics”) folders hold the multimedia, but don’t be surprised if
you also find JPEGs, GIFs, TIFFs, PNGs, and the occasional (but reward-
ing) QuickTime movie file in one of these directories. To search for help
movies issue the following command at the Terminal’s command line:

$ 1s -i *.app/Contents/Resources/English.lproj/«Help=/xgfx | grep mov

What returns is a list of help movies, each preceded by its file serial num-
ber, also called the file inode. The —i option instructs Is to include the file’s
inode number in the listing. This list will vary depending on the types and
versions of the applications installed in the /Applications folder. Most of the
following files appear in archaic versions of iMovie and iPhoto, which I keep
around for reference reasons.

According to Apple’s developer documentation, inodes are “the focus of all file
activity in the file system.” Inodes, which describe each file in the Mac OS X file
system, actually consist of two parts: the serial number that's used to speed up file
lookup and its file’s metadata. In general, inodes are of most interest to program-
mers, who use them to directly access file data. You can read more about inodes
by issuing a man 5 inodes command at the command line.

440286 iMA.mov

1308976 hlp132.mov
1308991 hlp22.mov
1309286 hlp23.mov
1309287 hlp24.mov
1309288 hlp31.mov
1309289 hlp33.mov
1309291 hlp80.mov

To find a file by inode, use the find command. This command may take a
minute or two to run, depending on the extent of the folder and subfolders
it must search.

$ find /Applications -inum 440286
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find returns a list of all matching files, offering a complete path to the file;
for example:

/Applications/iMovie 2.app/Contents/Resources/English.lproj/iMovie
Help/gfx/iMA.mov

Searching frameworks

Frameworks require a slightly different approach for searching than applica-
tions. Keep in mind that frameworks (both private and public) are subject
to version changes. So you must always search through “current” items.
That being said, frameworks use a folder structure that mirrors application
bundles, including localized Iproj subfolders. To search through the private
(mostly application specific) frameworks for AIFF files, do the following;:

$ cd /System/Library/PrivateFrameworks
$ 1s *.framework/Versions/Current/Resources/*.aiff

Use a similar approach to search through the localizations:
$ 1s «.framework/Versions/Current/Resources/English.lproj/«.aiff
Keep in mind that the results of these searches will depend on both the

applications and the versions you’ve installed. For more results, you may
want to search for *tiff rather than *aiff.

To search the System frameworks, simply substitute Frameworks for
PrivateFrameworks.

Searching for common file types

Some resources are commonly used across different applications. Pictures
are just one example of a frequently occurring file type. When a search
returns dozens or even hundreds of hits, you can reissue the search and
direct the output of the search command to save the results in a file on your

hard disk.

The following example searches through the Applications folder, looking for
all TIFF image files that use either a .tif or .tiff extension. Each item returned
is saved into the alltiffs.txt file, which is created on the Desktop. Notice that
the first Is command creates the file (using »>) and the second appends to
that file (using >>).

$ cd /Applications

$ 1s *.app/Contents/Resources/#.tifx > ~/Desktop/alltiffs.txt
$ 1s .app/Contents/Resources/English.lproj/*.tif >> ~/Desktop/alltiffs.txt

Use the word count command, we, to count the hits. With the - option, wc
returns the number of lines listed in a file. I found over 2000 TIFFs in my
Applications folder.

$ we -1 ~/Desktop/alltiffs.txt

)
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Now open the alltiffs.txt file in TextEdit for convenient viewing:

$ open -e ~/Desktop/alltiffs.txt

The —e option instructs the open command to open the specified file in
TextEdit.

Finding and Changing Images

As you're about to find out, it’s just as easy to customize application images,
as it is to alter their sounds. Follow these directions to add a personal touch
to iPhoto’s About Box.

1.

Make sure that iPhoto isn’t running before you start experimenting
with its contents. If it is, select iPhoto — Quit iPhoto from the menu
bar, or use the standard 8-Q keyboard shortcut to quit iPhoto.

. Open a Finder window and go to the Applications folder (Shift-38-A),

select iPhoto, Control-click (right-click) on the application icon and
select Show Package Contents from the context menu.

Navigate to the Contents/Resources directory. To speed up the process,
hit the C key, then $8-3 to switch the Finder window to Column View
mode.

Look inside the Resources folder for a file named AboutImage.tif.

Create a duplicate copy of AboutImage.tif by selecting the file in the
Finder and then selecting File = Duplicate (88-D) from the menu bar,
which creates a copy of the file in the same directory and names it
Aboutlmage copy.tif. *

Now open the original image (AboutImage.tif) in your favorite image
editor. I personally like the price point and features of Adobe Photoshop
Elements. Lemke Software’s GraphicConverter

Finding and Changing Images

TOOLS YOU NEED:
FINDING IMAGES

For working through the examples in
this section, you'll need the following
applications:

« iPhoto (/Applications)

* An image editor, such as Adobe
Photoshop Elements (http;//www.
adobe.com)

(http://www.lemkesoft.com) is another nice choice.

 Aboutlmage.tif @ 100% (Background, RGB)

59, 100 150

[200

250 =00 250 o0 430 j500 530, 3

Since most applications will not open files from |
within an application bundle, either drag the origi-
nal TIFF image file to an application icon in the
Dock, or make an alias (File = Make Alias, $8-L)
and then drag the alias to the Desktop.

i

Edit the image, and let your imagination run wild.
Make sure to leave room for the text that will be
added to the large white space at the bottom right
of the image. ** ReferenceFigure 3-9 *

o T e T e
oA WA FOVPRcov: Vi POV v Mo

iPhoto 4

Doc: 653K /815K

Save your edits and make sure you output the file i
using the TIFF format.

Figure 3-9. Editing iPhoto 4s About box.
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9. Open the image in Preview to make sure that it’s
been saved correctly and displays as you expect. If
needed, return to your image editor and make any
changes. If it does not look right in Preview, it won’t
look right in iPhoto’s About Box.

iPhoto 4

10. Launch iPhoto by either clicking on its icon in the
Dock, or double-clicking its icon in the Finder.

11. Choose iPhoto = About iPhoto. Assuming you've
edited the correct file in the correct language folder,
you’ll be treated to the new about box. Figure 3-10

offers just one example of what you might do with that
file.

If you like, you can create versions of the about
box for different Iproj folders. Make sure to move
AboutImage.tif out of the Resources folder. Use the
International settings pane trick (described in the
ATFF example found earlier in this chapter) to view

localized versions.

Figure 3-10. Many applications, such as
iPhoto, store window art in external files
that you can edit.

Peeking at (and Playing with) String Files

Most Mac OS X applications contain internationalized string files, typically
named Localization.strings. This file appears in each language-specific Iproj
folder, and allows developers to internationalize their applications by pro-
viding language-specific alternatives for string replacement.

String files generally use UTF-16 (Unicode) encoding, which makes them
difficult to view or edit in Terminal. (Some use UTF-8, but that’s less com-
mon.) UTF-16 uses extra bits for each alphabetic character, allowing a
much wider range of characters to be used. Unicode can handle character
sets ranging from French to Norwegian, from Japanese to Finnish, from
Korean to Dutch; visit hitp://www.unicode.org to learn more. The Unicode
site lets you view and download character code charts and search through
the character database.

Sadly, Mac OS X's installed versions of Emacs and Perl do not support UTF-16,
which makes automated substitution a bit of a pain.

&)
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Figure 3-11 shows what a Terminal window might look
like as you attempt to list the contents of a Localization.
strings file. Fortunately, you can easily view and edit
string files in TextEdit, which fully supports UTF-16 6 &) deuminal = more = S0x34
character encoding.

Lo i

In the example shown here, more treats each 8-bit byte
as a separate character, leading to the proliferation of the
~d items between each readable character.

Looking at internationalized strings in TextEdit

TextEdit reads, displays, edits, and saves string transla-
tion files. Since these files are embedded in bundles, it’s
generally easier to access them from the command line.

In the Terminal, navigate to a directory that contains I EEEEEE DT
one or more string files and use the open —e command,
the file opens in a new window in TextEdit.

reooooeeon O

Figure 3-11. Localization.strings files use
Unicode UTF-16 encoding, making them
hard to view or edit using Terminal.

$ cd /Applications/iChat.app/Contents/Resources/English.lproj
$ open -e Localizable.strings

Each string file is composed of a series of comment lines and replacement
lines. Comments are bounded by /x and */, and work just as they would in
C source code; items between the two symbols are ignored. Replacements
consist of two strings (characters appearing between matched quotation
marks) separated by an equal sign, and ending with a semicolon. The origi-

nal developer language (typically English) appears first; the translation on
the right appears after the equal sign. EEEENG AT STRINGS

For working through the examples in

Example 3-1 shows a small portion of iChat’s Italian localization. Notice the this section, yolIlnecal ek LI

use of the accented ¢, an item that does not normally appear in American

. : applications:
English character sets. (You’ll learn how to add your own accented Unicode PP
characters to strings files later in this chapter.) « Terminal (/Applications/Utilities)
Example 3-1. A snippet of iChat’s Italian localization file. * Textkdit (/Applications)
/x Alert title: enable service sheet argl:service name */ * Calculator (/Applications)

"% is disabled" = "%® & disattivato";
* Xcode (http;//developer.apple.

/* Text/Audio/Video choose window text message: person is offline */ com)

"%0 is offline." = "%® non & in linea.";

/* Format for a person or card name plus email (argl:name, arg2:e-mail
address) */
"%®, with e-mail address %@" = "%, con indirizzo e-mail %@";

Items that start with a percent symbol (%), such as %@, are formatting
placeholders. At run time, the program replaces them with text to produce
complete strings, such as “Joe is offline,” or “Joe non ¢ in linea.” Other
formatting items include %d (integers) and %f (floating point numbers). As
with comments, these placeholders should be familiar to those acquainted
with the C programming language.

/i
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Using TextEdit may prove a bit frus-
trating for those readers who are
comfortable using Emacs, vi, or even
pico or ed, because it does not offer
regular expression substitution.

If you're not used to working with C and want to learn a little more, one book
that's a must-have is The C Programming Language, by Brian W. Kernighan and
Dennis M. Ritchie (Prentice Hall). In programming circles, this book is a classic.
There is also a companion workbook, sold separately.

You can edit the files by changing the right-hand set of strings. The right-
hand strings define the localized version that automatically translates from
the original. Make sure to retain any % placeholders. For example, you might
add an apologetic note to a translation:

/* Text/Audio/Video choose window text message: person is offline */
"%® is offline." = "%® non & in linea. Mi dispiace molto.";

WARNING

Never alter the left-hand strings or the translations will not work.

Example: editing Calculator’s strings

The Calculator application is one of Mac OS X’s simplest built-in applica-
tions and has, perhaps, the fewest number of strings to customize. In the
following steps, you’ll create a new localization for Calculator and edit the
internationalized strings. Rather than add meaningful localizations, you’ll
simply tag the strings so you can instantly identify how each string method
is applied.

1. Make sure that the Calculator application isn’t running; if it is, quit the
application with 8-Q.

2. Open a Finder window and go to the Applications folder (Shift-88-A).
Select Calculator and choose File = Duplicate (88-D); the Finder cre-
ates a new copy, which you can use as a backup.

3. Select Calculator. Control-click (right-click) and choose Show Package
Contents. Navigate to the Contents/Resources folder.

4. Select the English.Iproj folder and choose File > Duplicate (8-D) to
make a duplicate copy of the folder. Rename the new copy en_CA.Iproj;
this name refers to Canadian English.

Alternate English dialects are written asen followed by an underscore ()
and a two-letter uppercase variant. Examples include British English (en_GB),
Canadian (en_CA), and Australian (en_AU). This naming convention extends
to all languages and variations. The first two-letter core language uses the 1SO
639-1 standard. The two-letter uppercase variants are defined by 1S0-3166. You
can find a complete list of both standards at the International Organization for
Standardization (http;//www.iso.ch).

@
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5. Find the Localizable.strings file, located in the new en_CA.Iproj folder.
Select the Localizable.strings file and drag it onto TextEdit’s icon in the
Dock to open the file.

6. In TextEdit, open the Find/Replace panel (Edit > Find — Find, $-F).
Find each occurrence of = “ (an equal sign, followed by Space, followed
by a double-quotation mark). Replace this with =
“XX (an equal sign, followed by Space, followed by
a double-quotation mark, followed by xX). Click on eo6
the Replace All button. e iy

Infinity”;
Inf inity™
“Hot @ runber”;

“valye ton high” = “value too high";

j Localizable.strings

The Find/Replace function adds the letters XX to the
start of each translated string. This provides easily e

identified visual markers for you to spot while run- e« e
ning the program. **Reference Figure 3-12**

SOVERFLOW = “Overf low*;
“Currency” = “Currency™;

“Bosic” = “Basic”;

StopeSavedFi leNone” = “tope.txt";
“ShowTape” = “Show Poper Tope”;
“HideTope" = “Hide Poper Tape”;

7. Save your work by selecting File — Save (88-S).

“last upaated® = “Last Updated:
“Begin Conversion” - “Begin Conversion”;

8. Next, change your Mac’s language settings to S —— —
Canadian English. Launch System Preferences (# — — ::: - ]
System Preferences), and click on the International | ‘— @ignore Case @ Wrap Around  (Contans )
preference panel. If Canadian English is not already e (Repice ) (Replace Find ) (Previous ) (et )

listed, click Edit. Locate Canadian English and
check it; click OK. Canadian English now appears
in the list of available Languages. Drag Canadian

English to the top of the list; this sets it as your new Figure 3-12. Adding markers to the
preferred language. **Reference Figure 3-13** replalcement string with the Find/Replace
pane

9. Now launch Calculator; make sure that you run the
version you just edited and not the copy. eon P =

« A9 @

Show All Displays Sound Classic Sharing Desktop & Screen Saver

Any instances of unexpected extra “XX"s generally appear

[ | Formats | InputMenuy ——-————

at the ends of some menu items, mainly due to the ellipsis i :
(the three dOtS). Canadian Ell!'iﬂh Drag Ianguag?s to se-t your preferred
el
Italiano time you log in. Changes take effect in
After you launch Calculator, look through the menus wH T b e e
and examine the presented windows. The changes you nray

made to the Localizable.strings file will appear on some,
but not all. This is because many of the menu items are
not affected by Calculator’s Localizable.strings; they’re
actually defined in the application’s main NIB file. In
the following steps, you’ll continue the localization | =/ @

(1) Your preferred language differs from that
of your currently selected date, time, and
number formats. You can change your

Francas i A\ Changes take effect in the Finder the next
l formats in the Formats tab.

Figure 3-13. Setting the preferred language
with the International preferences pane.
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process and update the NIB strings, to complement the
Localizable.strings. **Reference Figure3-14**

1. Quit Calculator with 88-Q.

2. Launch the Terminal application (/Applications/
Utilities); the following steps work best when run

é Calculator File Edit Convert Speech Window Help from the Command 11ne~
| XXBasic 21 [
XX Advanced %2 3. Return to the Canadian English Iproj folder. You’ll
XX Hide Paper Tape

—_— find en_CA.lproj in the Resources folder of the
DiopiayiEoinds altered Calculator application.

K cuis = 4. Locate the Calculator.nib file, which is in the en_
_ _| CA.Iproj folder. It defines the windows, menus, and
e weglan strings used by the Calculator application. Quite
: {i & a few strings are bundled in the Calculator.nib file
s s e+ (which is actually a folder). You’ll need to replace
R EN R this file to update your strings by using the follow-
L = ing command:

$ mv Calculator.nib Calculator.orig.nib

Fi -14. The Calculator ch . ) .
itlsg;r;]z items v?/hizc;oi(zl:)fia?ﬁﬁ: 5. The nibtool utility (installed with the Xcode Tools), allows you to

localization file. retrieve all the strings from a NIB file. Use the —L flag and redirect
your output to a new strings file. Be careful, and watch your upper- and
lowercase characters.

$ nibtool -L Calculator.orig.nib > nib.strings

6. Open the new strings file in TextEdit:
$ open -e nib.strings

7. In TextEdit, open the Find/Replace panel (Edit > Find — Find, or 3-
F). Find each occurrence of = “ (an equal sign, followed by a Space,
followed by a double-quotation mark). Replace this with = “ZZ (an
equal sign, followed by a Space, followed by a double-quotation mark,
followed by 77). Click the Replace All button. This adds the letters 7z
to the start of each translated string, providing visual contrast between
the strings changed in the localization file (XX’s) and the strings changed
in the NIB file (ZZ’s).

8. Save your work by selecting File = Save (8-S) from the menu bar.

9. Use nibtool to create a new Calculator.nib, which combines the edited
strings with rest of the original NIB file:
$ nibtool -w Calculator.nib -d nib.strings Calculator.orig.nib

After the conversion finishes, check to make sure that a new Calculator.
nib file was created.
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10. Now launch the Calculator, making sure that you
run the altered copy. As Figure 3-15 shows, each
string tag (XX or ZZ) instantly identifies which
method was used to localize each string. In this
example, XX tags indicate strings updated in the
Localizable.strings file. ZZ tags correspond to
strings appearing in the NIB file.

Obviously, these steps won’t create a real localization;
only careful edits and thoughtful translations can do
that. However, by following this example, you've seen
how easily you can produce and edit the strings needed
for a fully internationalized application.

Before you finish, make sure to return your machine to
its original settings:

Restore your original language settings
Open System Preferences and select the International
preference panel. Click Language, and then drag
your preferred language to the top of the list. Close
System Preferences.

Quit Calculator
Exit your modified version of Calculator.

Clean up
Delete the modified version of Calculator.app, and
then change the name of the copied original from
Calculator copy to just Calculator (you don’t have to
worry about adding the .app extension).

Using Unicode strings in TextEdit

Although TextEdit allows you to add Unicode characters
to your string files and other documents, it’s not immedi-
ately obvious how to accomplish this task. In the follow-
ing steps, you’ll discover several tools you can use.

1. Launch System Preferences, either by clicking on its
icon in the Dock or from & — System Preferences.

2. Click on the International preference panel.

3. Click the Input Menu tab. The Input Menu consists
of a list of items, each preceded with a checkbox.
Figure 3-16 shows the default presentation for a US-
based Macintosh.

Peeking at String Files

é Calculator ZZ File ZZ Edit ZZ Convert ZZ Speech ZZ Window ZZ Help
- -

XX Basic ®1
XX Advanced #®2

XX Hide Paper Tape .

ZZ Precision >
ZZ Display Format >

Figure 3-15. The updated Calculator
application with its tagged strings.

868o

« W80

Show All . Displays Sound Classic Sharing Desktop & Screen Saver

International (=)

Language | Formats | Inp j

Select the keyboard layouts, input methods, and palettes that appear in the
input menu.

2me [ mput type LT ]
Eys. Keyboard Roman
Japanese Kana Palette Palette Japanese
=) haracter Palette Palette Unicode
] EBkeyboard viewer Palette Unicode
] & «Koroeri Input Method Japanese
B Half-width Katakana
¥ EY romaji
[ I3 Full-width Roman
O ainu
¥ B3 Hiragana
¥ B Katakana
] @ Hangul

4l

Input Methad Korean

@) @

") Show input menu in menu bar

Figure 3-16. The Input Menu pane of
International settings allows you to select
keyboard layouts and palettes that help
you build rich, multi-language Unicode
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If you click the checkbox next to the option “Show input menu in menu bar,” the
flag of the default keyboard layout appears in the menu bar. For example, if your
keyboard layout is for the U.S., you'll see the Stars and Stripes appear as the icon
for the Input Menu in the menu bar.

v E US.

[ Show Character Palette
& Show Keyboard Viewer
Show input mode palette

Open International...
T m——

@ ) Tue 12:48:41 PM
= 3 - PR

4. Check Character Palette and Keyboard Viewer.
g These two palettes provide direct access to extend-

ed character sets.
e

5. Select the checkbox next to “Show input menu in
g menu bar.” This option adds the Character Palette
. and the Keyboard Viewer to a menu in the menu bar

for easy access, as shown in Figure 3-17.

s | I
P9

Figure 3-17. A flag icon in the menu

bar indicates the current setting for
internationalized keyboard input, here
using US English. This flagged menu
allows you to select a language and, if
youve enabled the options, to access the
Character Palette and Keyboard Viewer.

The Latin-1 Supplement list
offers a particularly useful set of
accented characters.

TOOLS YOU NEED:
USING UNICODE STRINGS

For working through the examples in
this section, you'll need the following
applications:

« System Preferences (/Applications)

« TextEdit (/Applications)

. Launch TextEdit and open a new document (File > New), suitable for

experimenting in.

. In the menu bar, click on the Input Menu and select the Show Character

Palette option.

. Select Unicode from the View pop-up. Click By Category. Select any of

the items in the scrolling list on the left.

In TextEdit, begin to type normally. When you need to add a Unicode
character, locate and double-click on the character in the Character
palette. New characters appear in the front-most application in the
focused window at the insertion point, as shown in Figure 3-18. Use
the View pop-up to select from a variety of core language families. You
can use the Character Palette to add ornamental punctuation, accented
characters, currency symbols, and more.

2866 Character Palette =
® O M Untitled 6.txt
view: Largo al factotum
{ by Radical | [ Code Tables | Favornes | | ‘della gitta
T —— ————— | Presto a hottega
aafdaadaaa
J~ Scientific Symbols a@bcgcéeedd
7 Dental Symbals deecécéecéeedt Sono |l factotum
@& Phonetic Symbols ggh hiiiiii de la citta
& Hiragana ! J_ J‘ k lv . Iv I ITlI"ll'J
nniannoddadad
F Karakana ok, & i P
; dooweodpqr fF
ARtatin ss§8sdtituan
m Greek dddandaian
A Cyrillic LMiavwxyyvzihk
9
- Box Drawing v|Z & ]J [ i3
W Character Infa
e Related characters :
- Aa*AAARAAAAdaaaap
e [ ¥ T om T £ 7 /
O N e S ———
dAdAa**AanaAaiid,
Kun Reading ©
On Reading :
P Font Variation (_Add to Favorites ) Insert b]
7

Figure 3-18. Use the Character palette to add Unicode to your text. Useful character groups
in this palette include punctuation, Greek letters, digits, scientific symbols, and more.

)
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When you encounter symbols that you use over and over again, such as an
accented & or the note symbol (AU), consider adding them to your favorites for
quick access. Just click Add to Favorites and the characters will appear in the
Favorites tab.

10

11.

12.

13.

14.

. Once you're satisfied with your understanding of the layout and opera-

tion of the Character Palette, click on the Input Menu and select Hide
Character Palette (or click the small red close button at the top-left of
the palette).

To add extra languages to the Input menu, click on the Input Menu and
select Open International. Add an extra language or three, so you have
several to select from. French, German, and Italian all offer items that

Peeking at String Files

do not appear in the standard

English character set.

Open the Keyboard Viewer
(Input Menu —> Show Keyboard
Viewer). This tool helps people
who are more comfortable using

® O ® Uuntitled 6.txt

Largo al factotum
della citta

a keyboard layout to enter text de la citta
thanusing the CharacterPalette’s
table layout. (Superficially, the

viewer is similar to KeyCaps.) It 000

allows you to preview fonts and B DOoD oo
 type strings. <l D[[s]s]7]e]s
| -+ [afw]e]

Return to TextEdit and bring
your document window back
into focus. Use the floating key-
board to enter text. Each click

Keyboard Viewer

Font: | Lucida Grande Regular

on a keyboard button produces

a text character.

Click on the Input Menu and

select one of the new languages. The flag for the Input menu changes to
reflect the currently selected language. Return to TextEdit and continue
typing with the Keyboard Viewer; the keyboard layout updates to reflect
the new language, as shown in Figure 3-19.

To learn more about Apple’s Internationalization tool suite, visit http;//developer.
apple.com/intl/localization/tools.html.

Figure 3-19. The Keyboard Viewer
localizes to match the settings used by the
Flag menu and the International settings
pane. Changing languages allows you to
access extended character sets using a
friendly keyboard layout. Click any key to

type it.
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Final Thoughts

Final Thoughts

This chapter introduced application diving—how to delve into application
bundles, search around, and even change the resources found there. You
saw how to find, customize, and use many different file types. You learned
about internationalizing programs and creating Unicode strings. Before you
move on to icons and extensions, here are a few key points to ponder about
the material covered in this chapter.

Most items appear in the same places (or nearly the same places) in applica-
tion after application.
The more familiar you are with the standard folder and subfolder hier-
archy, the easier it becomes to weed out repetitive items and focus your
interest on unique and intriguing assets.

Think international.
Understanding internationalization is as important a part of application
diving as searching for cool pictures. Not everything wacky or wonder-
ful appears just in English.lproj directories.

Take charge of your localization.
If you live in Canada, England, or Spain and have bought software
intended for France, the United States, or South America, create a local-
ization that fits the way you work. Don’t settle for “recognize” when
you prefer “recognise.” Colour your world and customize your apps.

Restraint is overrated, particularly when you're just starting to explore.
If you’re using the methods in this chapter to learn more about OS X
applications, then don’t hold yourself back by the bounds of good taste.
Work on a copy and knock yourself out—at least, creatively that is. You
can always return to the original.

Don’t underestimate the usefulness of strong Unix command-line skills.
The command line opens up an entire world of power and possibility. If
you’re a bit out of practice or are new to the command-line world, you
might want to pick up a copy of Learning Unix for Mac OS X Panther
(O’Reilly). Even a small amount of knowledge goes a very long way in
the Unix world.

Make your applications more you.
If a smile in the About box cheers up your day, why not go ahead and
add one? Your software belongs to you.
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